Frankfurt University of Applied Sciences

Dept. of Computer Science and Engineering

| | FRANKFURT
UNIVERSITY

OF APPLIED SCIENCES

Project Report
WS 2022
Master of Science (M.Sc.)

Edge-Computing (Framework: EdgeX)

Submitted by

Ruchit Dobariya (Matr. N - 1378799)
Fargina Mahmud (Matr. N - 1379510)
Nelli Aghajanyan (Matr. N - 1378647)
Bhargav Anghan (Matr. N - 1387230)

Under the guidance of
Prof. Dr. Christian Baun



Contents

Contents

[List of Figures|

1__Introductionl
(1.1  kEdgeX Foundry Service Layers|. . .

2__Installation|
2.1 System Requirments| . . . ... ..
[2.2  Installation of Raspberry Pi OS] . .

[2.3 Installation Docker and docker-compose, . . . . . . ... ... ... ... ... ..

[2.4 Installation and Starting EdgeX Foundry| . . . . . . . . .. ... ..o

[3 Graphical user interfaces|
[3.1 Raspberry Pi OS5 User Intertace] . .
(3.2  kdgex Ul user interfaces| . . . . . .

I Deovi Tonl
4.1  Device Profilesl . . . . . ... ...

[5__Data Generationl

(5.1 Temprature and humidity Sensor (DHT22)[ . . . . . .. ... ... ... ... ... ..

(5.2 Export data to Edgex{ . . ... ..

6 Export Edgex data to AWS|
6.1 DynamoDB Implementation| . . . .
6.2  AWS Lambda Implementation| . . .
6.3 AWS Gateway API Implementation|

Conclusion

[Bibliography|

10
10

13
13
14

16
16
17
20

21

22



List of Figures

1.1 EdgeX gateway between the “things” and the IT-System [9] . . . .. ... ... ... 1
1.2 EdgeX platform architecture [8 . . . . . . . . . ... ... 2
3.1 Raspberry P1 OS GUI [?]|. . . . . . . ... 8
[3.2  Portainer Login| . . . . . . . . . . 9
B3 Portaimer Ull. . . . . . . . . . 9
4.1 sensorClusterDeviceProfile.yaml| . . . . . .. ... ... ... ... .. ... .. ... 11
(5.1 DHT22 and Raspberry Pi connection |5 . . . . . ... ... ... L. 14
[5.2 Create Stream Using Postman| . . . . . . . . . . . . . .. ... ... .. ... ..... 15
[>.3 Create Temparature rule Using Postman| . . . . . . . ... ... ... ... ...... 15
[.4 Create Humidity rule Using Postman| . . . . . . ... ... ... ... ... ...... 15
6.1 AWS DynamoDB tablel . . . . . . ... ... 17
6.2 Create anew [AM role| . . . . . . . . . . ... 18
6.3 Create new Lambda servicerole| . . . . . . . . . . ... ... ... ... . ..., 18
6.4 Index.js(Appendix) |. . . . . . .. 19
6.0 API Gatway | . . . . . . . . 20

i



Chapter 1

Introduction

What is Edgex Foundary? In simple words, EdgeX Foundry connects to devices, sensors, actuators,
and other IoT objects in the real world. It is an open source, vendor-neutral, adaptable, and in-
teroperable software platform. Since it acts as a link between modern information technology (IT)
systems and actual items that are capable of sensing and acting in the real world, EdgeX can be
regarded as edge middleware. In order to reduce risk, accelerate time to market, and enable scale,
the EdgeX platform facilitates and encourages collaboration among the rapidly growing community
of IoT solution providers in an ecosystem of interconnected components. MQTT, REST are just a
few of the IoT device connectivity protocols that EdgeX provides. It permits for encryption, trans-
formation, filtering, and formatting before delivering the data through multiple protocols, including
MQTT, to an external source. Data is typically not stored in the EdgeX Gateway itself for a long
time. KdgeX is made up of several services, some of which the user has the option to enable or
disable. For instance, it is possible to build rules that, when the conditions are met, automatically
perform a specific behaviour [7]. Figure shows the general overview of the edgex middleware.
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Figure 1.1: EdgeX gateway between the "things” and the I'T-System [9]

1.1 EdgeX Foundry Service Layers

A set of open source micro services is called EdgeX Foundry. These micro services are separated into
2 underlying augmenting system services and 4 service layers.

EdgeX Foundry’s 2 underlying System Services :

o Security

o System Management



EdgeX Foundry’s 4 Service Layers:

o Device Services Layer
» Core Services Layer
» Supporting Services Layer

o Application Services Layer
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Figure 1.2: EdgeX platform architecture [§]

The Device Services Layer, actually interacts with IOT devices and sensors while also connects other
service layers.

The majority of an EdgeX instance’s natural understanding of what "things" are connected, what
data is passing through them, and how EdgeX is set up is found in the core services.
Core layer has the following micro services:

« Core data
o Command
« Metadata
o Registry and Configuration

The supporting servies are responsible for scrubbing in terms of Edgex means for data clean up,
logging and scheduling. Some of the services are:

e Rules Engine



o Scheduling
o Logging
o Alerts and Notifications
The last layer is Application Services Layer, which is responsible for sending this data after scrubbing

to endpoint or cloud. Ex. Amazon Web Services (Amazon IoT Hub), Google Cloud (Google IoT
Core), Azure IoT Hub, IBM Watson IoT.



Chapter 2

Installation

2.1

System Requirments

For Edgex Foundary(Used in this project):

Ubuntu 22.04

Internet Connection
Minimum 1GB Memory
64bit CPU

Raspberry pi 3 Model B (For Sensor Data Generation)

2.2 Installation of Raspberry Pi OS

In this section, we discussed about how to install Raspberry Pi OS on an SD card with laptop or
PC. Below are the steps in order to successfully install Raspberry Pi OS on an SD card [I1].

1.

Download the Raspbian OS ISO from https://www.raspberrypi.com/software/| official
website

o Use Raspbian Stretch with desktop and recommended software

Install a Raspberry Pi Imager that can create an image of your Raspberry Pi OS on your SD
card from https://www.raspberrypi.com/software/

Select operating system to be written on your SD card by clicking on the option “CHOOSE
OS”.

Click on "Settings" and add wifi "USERNAME" and "PASSWORD'
choose "STORAGE" option, select SD Card
Click on "WRITE".


https://www.raspberrypi.com/software/
https://www.raspberrypi.com/software/

2.3 Installation Docker and docker-compose

Commands to install Docker and Docker Compose:

1. Update the system

2. Install the Docker-CE

3. Now install docker-compose

2.4 Installation and Starting EdgeX Foundry

Commands to install Edgex Foundary:

1. Create directory with name edgex

2. Download the docker-compose.yml

3. Pull the containers and list downloaded

4. Start EdgeX Foundry



5. Stop EdgeX Foundry



Chapter 3

Graphical user interfaces

3.1 Raspberry Pi OS User Interface

Connect Raspberry Pi to laptop display. Follow the below step to install User Interface [3].
1. Turn on Your Raspberry Pi
o Insert SD Card in Raspberry Pi. Turn it on.
2. Make connection with Raspberry Pi using SSH. Run below command in command prompt.

 ssh pi@Raspberry Pi’s IP Address]

o Default USERNAME and PASSWORD.
o« USERNAME: pi

« PASSWORD: raspberry

3. Install VNC Server

« sudo apt-get update

o sudo apt install realvnc-vne-server realvnc-vne-viewer
4. Enable VNC Server.

« sudo raspi-config

e Select "Interfacing Options"
» Navigate to “P3 VNC”

e Click on "Yes"

5. Install a VNC Viewer.

e Download VNC Viewer from https://www.realvnc.com/en/connect/download/viewer/
official website.

e Start VNC Viewer.

6. Now, you can access Raspberry pi OS using IP address of Raspberry Pi in laptop. As shown
in figure [3.1


https://www.realvnc.com/en/connect/download/viewer/

Jul1 12:22PM

192.168.1.5 (raspberrypi) - VNC Viewer - @ (=

Figure 3.1: Raspberry Pi OS GUI [?]

3.2 Edgex Ul user interfaces

In order to access Edgex Foundry using a Ul, we need to add the Ul service inside the docker com-
pose file. For this purpose, we have used Portainer Ul which is a powerful graphical Ul, where the
containers, images, volumes and networks are visualised. To avoid working with terminal and all the
commands, Portainer can be used to control the Docker resources [2].

portainer:

image: portainer/portainer

ports:

- "0.0.0.0:9000:9000"

container name: portainer

command: -H unix:///var/run/docker.sock
volumes:

- /var/run/docker.sock: /var /run/docker.sock:z
- portainer_data:/data




While keeping the identation we need to add the above mentioned image with all its configuration
in docker compose file —> below the services section. The Portainer listens on port 9000, upon first
usage we need to set a password for admin user when we visit the page. Figure [3.2 shows how the
login page looks like. We use the following credentials

username: admin

password: raspberry

Activities @ Google Chrome Julé 7:05PM
Portainer x -+ v = a x
= C A Notsecure | 192.168.1.3:9000/#/auth o< v 0@ :
s
a
a
) Login

® GEaEB8

Figure 3.2: Portainer Login

In the figure [3.3] we can see the screenshot of Portainer Web UIL. The details as the number of
networks, container and images can be easily tracked on this UI.

Activities ® Google Chrome Julé 7:06 PM v i
Portainer | primary X e v - g X
<« @ A Notsecure | 192.168.1.3:9000/#1/1/docker/dashboard o< v O@
ﬁ portainer.io Dashboard 0 admin
Endpoint summary Fmysccount @logeut
Home
¥ PRIMARY Endpoint info
Dashboard
= Endpoint primary @ 4 EB12.4 GB - Standalone 20.10.12
URL /var/run/docker.sock
Tags

v
-«

1 24 @ Ohealthy (15 running

& 0 unhealthy & 9 stopped

Stack Containers
4 ¢16c8 16

o Images e Volumes

& A new version is available 6
Networks

192.168.1.3:9000/#!/1/docker/volumes

Vs

c@eeasn

Figure 3.3: Portainer Ul



Chapter 4

Device creation

4.1 Device Profiles

In this section we will describe how to send sensor data to Edgex Foundry. First of all we have to:

« create a device on Edgex

In order to do that we need to set the value, type, format and some other configuration.
To communicate with EdgeX Foundry, we are using the Postman application.

Step 1: Open Postman application

Step 2: Set method : POST ;

URI : http:\<edgexip>:48080/api/vl/valuedescriptor ;

Payload Setting : raw - JSON format ;

Payload Data :

{

"name": "humidity", "name": "temperature",

"description": "Humidity %", "description": "Temperature Celsius',
"min": "0", "min": "0",

"max": "80", "max": "80",

"type": "Int64", "type": "Int64",

"uomLabel": "humidity", "uomLabel": "temperature",
"formatting": ""labels": [ "formatting": ""labels": [
"environment", "environment",

"humidity" "temperature"

] ]
} }

Response status should be 200 OK.

« upload the device profile

The device profile is a yaml file that contains device name and the list of data it can han-
dle.

Step 1: Open Postman application

Step 2: Set method : POST ;

10


http:\<edgexip>:48080/api/v1/valuedescriptor

URI : http://<edgexip>:48081/api/vl/deviceprofile/uploadfile|;
Payload Setting : form-data : KEY - File;

Select the yaml file : sensorClusterDeviceProfile.yaml

Have file as the KEY

The figure depics the sensorClusterDeviceProfile.yaml file, which is used to describe the
device - data formats and commands.

. [ ] sensorClusterDeviceProfile.yaml

4 P sensorClusterDeviceProfile.yaml|

SensorData
Raspberry Pi Foundation
: "Raspberry Pi 3b+

rpi
Sensor data for temperature and humidity

: temperature
Temperature

Int64",
: humidity

Humidity

Int64",

Figure 4.1: sensorClusterDeviceProfile.yaml

o wvalue descriptor and device profile are ready to create the device

Step 1: Open Postman application

Step 2: Set method : POST ;

URI : http://<edgexip>:48081/api/vl/devicel;
Payload Setting : raw - JSON format;

Payload Data :

{

'"name": "Temp and Humidity sensor data',
"description": "DTHI11 sensor data",
"adminState": "unlocked",

"operatingState": "enabled",

"protocols":

"example":

"host": "random",

"port": "1000",

"unitID": "10"

11


http://<edgexip>:48081/api/v1/deviceprofile/uploadfile
http://<edgexip>:48081/api/v1/device

"labels": |

"Humidity sensor",
"Temperature sensor",
"DHT11"

J,

"location": "Germany",
"service":

"name": "edgex-device-rest'

)
"profile":
"name": "SensorData'

Response should be 200 OK.

After all of these steps, now the EdgeX Foundry is ready to capture temperature and humidity
data.

send sensor data from client side
We can use Postman to do so using POST request and the URI as http://<edgexip>:
49986/api/vl/resource/Temp _and Humidity_sensor_ data/temperature

fetch the data
To fetch the same data from EdgeX we can use the GET api and URI http://<edgexip>:
48080/api/vl/reading from server side.

12


http://<edgex ip>:49986/api/v1/resource/Temp_and_Humidity_sensor_data/temperature
http://<edgex ip>:49986/api/v1/resource/Temp_and_Humidity_sensor_data/temperature
http://<edgex ip>:48080/api/v1/reading
http://<edgex ip>:48080/api/v1/reading

Chapter 5

Data (Generation

5.1 Temprature and humidity Sensor (DHT22)

In this project we are gernrating real data time data of Temprature and humidity using DHT22 and
Raspberry Pi.

DHT?22: The DHT22 is a basic digital temperature and humidity sensor. It measures the humidity
and temperature of the air around it using a thermistor and a capacitive humidity sensor, and it
outputs a digital signal.

o Accuracy:+2

o Humidity Range:0 100
o Temperature:-40°C  80°C
o Output Type:Digital

o Voltage - Supply:3.3V 6V

Connection circuit diagram is shown in figure [5.1
In order to run python script on raspberry pi OS. We require to install some library and packages.
Follow below commands to install python and other things [6].

« sudo apt-get update

« sudo apt-get upgrade

» sudo apt-get install python3-dev python3-pip

o sudo python3 -m pip install —upgrade pip setuptools wheel

« sudo pip3 install Adafruit-DHT

13
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Figure 5.1: DHT22 and Raspberry Pi connection [5]

5.2 Export data to Edgex

In this section we discuss about sending data from Edgex foundary to AWS cloud. Here, Kuiper
Rules Engine is used to export the data. Edgex-kuiper is running on port 48075.

There are two step to setup rules engine.

1. Create Stream

2. Create rules
1) Create Stream
Here, we used Postman to create stream and rules. Just set url and payload shown in figure [5.2]
2) Create rules

Here, we created the rules into two separate categories: "Temparature' and "Humidity'. Our AWS
Dynamo DB end point is used as "Url", and the request type is "post'. For reference see figures

and [5.4] [4].
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http://192.168.1.3:48075/streams

POST ~  http://192.168.1.3:48075/streams
Params  Authorization — Headers (9) Body ®  Pre-request Script  Tests Settings
none i dat; form-ur ® raw binary GraphQL  JSON -~

14
2 "sgl": "create stream iotedgexdata() WITH (FORMAT=\"JSON\", TYPE=\"edgex\")"
3k

Body Cookies

Headers Test Results

Pretty Raw Preview Visualize Text ~

Figure 5.2: Create Stream Using Postman

http://192.168.1.3:48075/rules

POST ~  http://192.168.1.3:48075/rules
Params Authorization Headers (9) Body ® Pre-request Script Tests Settings
none form-data x-www-form-urlencoded @ raw binary Graph@L JSON
14
2 "id": "TemperatureData”,
3 "sql": "SELECT temperature, meta(Device) AS device FROM iotedgexdata WHERE (meta(device) =\"Temp_and_Humidity sensor_data\")",
4 "actions”: [
5 i
6 “rest”: {
7 “dataTemplate": “{\"content\":\"json .\", \"Temperature\" FEONTAN TS T AR
] "method”:  "post”,
9 "sendSingle”: true,
18 "url": "https://wb@qxShwdd.execute-api.eu-central-1.amazonaws.com/EdgeXFoundryCollectedData/data”,
11 "retryInterval®: @
12 i
13 .
14 1
15 “log": {}
16 i-

Body Cookies Headers Test Results

Figure 5.3: Create Temparature rule Using Postman

http://192.168.1.3:48075/rules

POST v http:/[192.168.1.3:48075/rules
Params Authorization Headers (9) Body @ Pre-request Script Tests Settings
none form-data x-www-form-urlencoded @ raw binary Graph@L JSON
14
2 "id": "HumidityData",
3 "sql": "SELECT humidity, meta(Device) AS device FROM iotedgexdata WHERE (meta(device) =\"Temp_and_Humidity_sensor_data\")",
a "actions®: [
5 i
6 "rest”: g
7 "dataTemplate": "I\ "content\":\"json .\", \"Humidity\":{{ ViR, \"Td\":\"f{.device}}\"1",
8 "method": “"post”,
9 "sendSingle”: true,
18 "url®: "https://wbB@qxShwdd.execute-api.eu-central-1.amazonaws.com/EdgeXFoundryCollectedData/data”,
1 "retryInterval": @
12 1
13 N
14
15 "log": {1
16 3

Body Cookies Headers TestResults Status: 201 Created Time: 8 ms

Figure 5.4: Create Humidity rule Using Postman
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Chapter 6
Export Edgex data to AWS

We have used four AWS services to export EdgeX data to AWS. These are AWS DynamoDB, TAM
Service, AWS Lambda and AWS API Gateway.

6.1 DynamoDB Implementation

The construction of database tables with limitless data storage and retrieval capabilities is possible
due to a fully managed NoSQL database service called AWS DynamoDB. While handling the data
traffic of tables over several servers, performance is automatically maintained. Additionally, it relieves
consumers of the burden of scaling and managing a distributed database. As a result, management
of hardware provisioning, setup, configuration, replication, software patching, cluster scalability is
provided by Amazon.We created a table in DynamoDB following the steps below:-

1. Go to https://console.aws.amazon.com/dynamodb/ to access the DynamoDB console.
2. selecting Create Table.

3. Do the following on the Create DynamoDB table screen:

4. Choose "loTDeviceData” as name of the table as shown in figure below.

5. Enter "Id" in the Partition key box for the Primary key. Choose string as the data type.

6. Select Create once the settings are exactly how you want them.
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https://console.aws.amazon.com/dynamodb/

DynamoDB Tables loTDeviceData

rates 1 «  loTDeviceData [ G | awors + | IEEEEEITE

Any table tag v
Overview Indexes Monitor Global tables Back »
Q
1 5 -
) General information
(o] loTDeviceData

Partition key Sort key

Id (String)

Capacity mode Table status

Provisioned ® Active

(® No active alarms

» Additional info

Figure 6.1: AWS DynamoDB table

6.2 AWS Lambda Implementation

One can run code without setting up or maintaining servers by using the compute service Lambda.
While your code is running on a high-availability compute infrastructure, Lambda manages the
compute resources, including server and operating system maintenance, capacity provisioning and
automatic scaling, code monitoring and logging. With Lambda, we can run code for virtually any
form of application or back-end service. Just we need to submit code in one of the languages that
Lambda supports.

First lambda functions are required in order to access the newly constructed DynamoDB table.
However, the newly generated table is first inaccessible to lambda functions. For accessing lambda
function, we have to create IAM service. Utilize the management console to access the IAM service,
choose "Roles" from the left-hand menu and name the new IAM service role as "loTDeviceDataAccess"
(as seen in figure 6.2), and then press "create role" button.

Secondly, "AWS service" selected and pick Lambda as the service this role is intended. Then, click on
"Next" In the Permissions, and type "AWS Lambda Basic Execution Role" into the search window.
Click "Next" after selecting the role specified under that name. [I]

Now, Click "Create role" after naming the role as "StoreDeviceData". Select the newly formed role
and click "Add inline policy" as seen in figure 6.3 to grant this role more particular rights. Then, enter
"DynamoDB" in the service search bar and "Getltem" and "Putltem" in the actions search bar in the
next view.

17



Identity and Access
Management (IAM)

Q, Search IAM

Dashboard
' Access management
User groups
Users
Roles
Folicies
Identity providers
Account settings
' Access reports

Access analyzer
Archive rules

Analyzers

x IAM > Roles

Roles (5) info . Delete

An IAM role is an identity you can create that has specific permissions with credentials

that are valid for short durations. Roles can be assumed by entities that you trust

Q Search 1 &
Role name - Trusted entities
AWSServiceRoleForAPIGateway AWS Service: ops.apigateway (§9 e-| !'_I_I_(E(_:!_BP_!_E_)
AWSServiceRoleForApplicationAutoScaling_DynamoDBTable AWS Service: dynamodb.application-autoscaling
AWSServiceRoleForSupport AWS Service: support (Serwce-LmkedRo\e)
AWSServiceRoleForTrustedAdvisor AWS Service: trustedadvisor [_%92/_!59_—_&1_95@_{:!_59[9)
loTDeviceDataAccess AWS Service: lambda
4 3

Figure 6.2: Create a new IAM role

* Amazon APl Gateway

APls

Custom Domain Names

VPC Links

API: EdgeXFoundryData
Resources
| stages
Authorizers
Gateway Responses
Models
Resource Policy

Documentation

APls > EdgeXFoundryData (wbOgxbhwdd) > Stages > EdgeXFoundryCollectedData Show all hints 9
Stages EdgeXFoundryCoIIectedData Stage Editor Delete Stage Configure Tags

» & EdgeXFoundryCollecledData
. Invoke URL: hitps://wb0qx5hwdd.execute-api.eu-central-1.amazonaws.com/EdgeXFoundryCollectedData

Settings Logs/Tracing Stage Variables SDK Generation Export Deployment History

Documentation History Canary

Cache Settings

Enable APl cache [
Default Method Throttling
Choose the default throttiing level for the methods in this stage. Each method in this stage will respect these
rate and burst settings. Your current account level throttling rate is 10000 requests per second with a burst of
5000 requests. Read more about AP| Gateway throttling

Enable throtting @ @

Rate 10000 requests per second

Figure 6.3: Create new Lambda service role
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Lambda functions are compatible with a wide range of computer languages. Because JavaScript was
utilized in this instance, Node.js has to be the runtime option. Select "Choose an existing role" from
the role-dropdown menu, then pick the recently created "StoreDeviceData' position.

Put the code from appendix file into the index.js file(as seen in figure 6.4). The event object containing
the entries "ID" in the json body will be received by the script when it is enabled. The "loTDevice-
Data" DynamoDB table is then updated with these two values. It also provides a response object
with the http response status in it[I].

Figure 6.4: Index.js(Appendix)
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6.3 AWS Gateway API Implementation

The Gateway API service supports RESTful-APIs. A RESTful API can be created by following
these steps.

1. Go to AWS-Managment console and select the API Gateway service.
2. For selecting REST API select the button "Create API”.

3. Choose the API-Name as "EdgeXFoundryCollectedData” and keep the endpoint setting on
regional. Select create API [10]

4. Create method and tools you want. We have created a POST HTTP method to send EdgeX
data to AWS.

5. Implement some kind of access protection and policy.

6. Deploy the APL.

Lambda Functions StoreloTDeviceData

StoreloTDeviceData Throttle || Copy ARN

v Function overview info

Description
gtoreloTDewceDat

Last modified

M: Layers (0) 26 minutes ago
AP| Gateway + Add destination Function ARN
i arn:aws:lambda:eu-central-1:9221

ction:StoreloTDeviceData

<+ Add trigger

Function URL Info

Figure 6.5: API Gatway
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Conclusion

At the end we have integrated every portion of the project. We have tested while integration. During
the test stage, we could see that data is being stored in AWS DynamoDB through API Gateway

from EdgeX.
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